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1 Overview of DGCS in Google Earth™ 

1.1 Introduction to DGCS EarthService™ 

EarthService
™

 is a cached tile service compatible with Google Earth
™

 mapping service that provides access to 
DigitalGlobe Imagery. EarthService provides native compatibility for KML-based Earth Viewers, including Google 
Earth.  

A user connects to the service from the Google Earth client, and downloads pre-cached imagery tiles and metadata. 
All transactions are encrypted using HTTPS and include a unique User ID in the form of a ConnectID. These 
ConnectIDs are created for each user through Manager Services. 

Figure 1.1 depicts the schematic representation of Earth Service capability. 

 

FIGURE 1.1  SCHEMATIC REPRESENTATION OF EARTH SERVICE CAPABILITY 

1.1.1 EARTHSERVICE LAYERS 

CitySphereTileService 

DigitalGlobe’s CitySphere
™

 product features 60 cm or better orthorectified color imagery for 300 pre-selected cities 
worldwide. These GIS-ready cities are available as off-the-shelf products and ready for immediate delivery. Each city 
is comprised of recent imagery, with initial imagery no older than 2006. The resolution and accuracy of CitySphere 
make it ideal for use as a basemap in your GIS, personal navigation mapping and mobile device applications, as well 
as many other location-based services. 

TABLE 1.1  SPECIFICATIONS 

FEATURES BENEFITS ADVANTAGES 

60 cm or better resolution Clearly discern features Increases your confidence for feature identification 

1:4800, 1:12000 or 1:50000 
orthomosaic 

Highly accurate Pinpoints features to within 2.5 meters 

Current off-the-shelf imagery Quick delivery of new 
imagery for your GIS 

Easy procurement process 

GIS-ready Ready for immediate use No extra effort or training required 

Affordable pricing Fits within your budget Potential to avoid RFP process 

Repeatable, consistent 
coverage 

Known update schedule and 
known update area 

Allows for easy budget planning 

FirstLook 

The Crisis Event Service (CES) provides access to pre- and post-event imagery over major disaster areas, as 
defined by the International Charter for Space and Major Disasters (http://www.disasterscharter.org/home), as well as 
user-defined areas approved by the DigitalGlobe Crisis Team. The layer includes imagery from DigitalGlobe’s 
QuickBird, WorldView1, and WorldView2 satellite constellation. It also includes WFS that allows the user to query 
data availability by different metadata attributes. 

The DigitalGlobe CES includes the following: 

http://www.disasterscharter.org/home
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 EarthService is a cached-tile service compatible with Google Earth. The service also provides both imagery and 
metadata layers. 

 A full featured Web Map Service (WMS) that provides both metadata and imagery layers to WMS clients. 

 A full Web Feature Service (WFS) that allows querying of data features by attribute. 

1.2 Introduction to DGCS MapService 

The MapService provides raster imagery data in multiple resolutions for use in GIS applications in various formats 
that support the WMS standard. The DigitalGlobe WMS supports the following operations: 

GetCapabilities 

The GetCapabilities request is used to obtain information about the supported map layers, which include various 
layers of imagery and metadata. 

GetMap 

The GetMap request is used to retrieve footprint geometry and metadata of the layers contained in the Online 
Catalogs. 

GetFeatureInfo 

The GetFeatureInfo request is used to obtain metadata about the features displayed in map images that are retrieved 
via GetMap requests. Filter calls from Applying Filters on page 22 can also be included to specify a certain dataset for 
which information is required. 

1.2.1 SERVICE DETAILS 

The DigitalGlobe WMS supports OGC WMS Version 1.1.1. The DigitalGlobe WMS supports KVP (Keyword Value 
Pair) request encoding only; SOAP (Simple Object Access Protocol) or other protocols are not supported. 

The DigitalGlobe WMS supports map layers of both imagery and imagery metadata. The data for these layers is 
supplied in the following way: 

 An imagery bounding box is returned when metadata layers are requested at smaller map scales (smaller than 
approximately 1:230,000). When a map scale larger than this is requested, only an image date is returned. 

 No imagery is returned when imagery layers are requested at smaller map scales (smaller than approximately 
1:200,000). At map scales larger than this, map images are returned. 

1.2.2 MAPSERVICE CAPABILITY 

MapService enables a user to access metadata by connecting from any WMS-compliant software, like Google Earth. 
All transactions are encrypted using HTTPS and include the ConnectID. 

The following figure depicts the schematic representation of MapService capability. 

 

FIGURE 1.2  SCHEMATIC REPRESENTATION OF MAP SERVICE CAPABILITY 

1.3 Introduction to DGCS Web Coverage Service (WCS) 

The Web Coverage Service allows the end user to directly download raster imagery data in either JPEG2000 or 
GeoTIFF format. The WCS supports the following operations: 

file://cofs1/l%20
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GetCapabilities 

The GetCapabilities request is used to determine the supported Coverages; each FinishedCatalog product will be 
listed and described as a Coverage. 

DescribeCoverage 

The DescribeCoverage request is used to obtain the detailed description of a supported Coverage. 

GetCoverage 

The GetCoverage request is used to obtain the actual product pixels (imagery) for download. 

1.3.1 SERVICE DETAILS 

The DigitalGlobe WCS supports KVP request encoding only; SOAP or other protocols are not supported. 

The WCS does NOT support the following optional capabilities: 

 Range Subsetting 

 STORE capability; all coverages are returned synchronously 

 Because full-resolution imagery is being retrieved, sometimes over limited 
bandwidth connections, the WCS will determine the size of the requested product. If 
it exceeds 1GB, an exception will be returned. Since the limit is based on file size, 
larger areas can be downloaded if JPEG2000 format is requested instead of 
GeoTIFF. 

 There will be a set of white-listed domains where a user can download unlimited 
quantities of Web Coverages. Users accessing the service from a non-white-listed 
domain will be limited to 1GB of downloaded data per day. Once this limit is 
exceeded, the user’s ConnectID will be disabled from non-white-listed domains, this 
ConnectID will still be active from white-listed domains.  

The WCS Service treats each available product as a separate coverage; therefore the imagery returned depends on 
the layer being accessed. 

The parameter used to request coverage is the Feature Identifier. This makes it convenient to request metadata for 
the product via the Feature service, and then request the actual imagery product via the WCS, using the same 
identifier.  

 Since additional Coverages will become available as data is added to the Service, 
the response to a GetCapabilities request will be updated each time a new product 
available. Therefore, care should be taken if client-side caching of the results is 
utilized. 

1.4 Google Earth System Requirements 
 Operating System: Windows XP, Windows Vista, Windows 7 

 CPU: Pentium 4 2.4GHz+ or AMD 2400xp+  

 System Memory (RAM): 512MB  

 Hard Disk: 2GB free space  

 Network Speed: 768 Kbits/sec  

 Graphics Card: 3D-capable with 32MB of VRAM  

 Screen: 1280x1024, "32-bit True Color"   

 NOTE: Google-Earth’s minimum and recommended system requirements for other 
Operating Systems are listed at: 
http://earth.google.com/support/bin/answer.py?hl=en&answer=20701 

 To install Google Earth, go to: http://earth.google.com/download-earth.html. 

http://earth.google.com/support/bin/answer.py?hl=en&answer=20701
http://earth.google.com/download-earth.html
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2 Accessing DGCS in Google Earth  

2.1 Opening DGCS in Google Earth 

DigitalGlobe Cloud Services can be accessed in one of the following ways: 

 Double-click the KMZ or KML file provided by DigitalGlobe which will automatically open Google Earth and load 
the layers. 

 DigitalGlobe layers can be added manually using the Web Service URLs provided by DigitalGlobe. 

2.2 Adding DGCS EarthService (Imagery) 

To access the DGCS EarthService, obtain a valid ConnectID from the DigitalGlobe Cloud Services Program Office. 
Once a ConnectID is obtained, EarthService can either be accessed via a web browser or by adding the URL as a 
network link. 

2.2.1 ACCESSING VIA A WEB BROWSER 

To access DGCS EarthService via a Web browser: 

1. Open a Web browser. 
2. In the URL address field, type the following: 

https://services.digitalglobe.com/earthservice/kmlaccess/DigitalGlobe:CitySphereTileService?connectid=<C
onnectID>  

 Replace <ConnectID> with the ConnectID provided by DigitalGlobe. 

 Confirm your URL with your DigitalGlobe representative. 

 Ensure that there are no spaces in the URL. 

3. Press the ENTER key on the keyboard. The File Download window displays (Figure 2.1). 

 

FIGURE 2.1  OPEN KML VIA WEB BROWSER 

4. Click Open. Google Earth will automatically open and load the layers, which will be populated in the My 
Places panel. 

 NOTE: If you want to save the file for later, you can click Save and save it to your 
computer.  

https://services.digitalglobe.com/earthservice/kmlaccess/DigitalGlobe:CitySphereTileService?connectid=%3cConnectID
https://services.digitalglobe.com/earthservice/kmlaccess/DigitalGlobe:CitySphereTileService?connectid=%3cConnectID
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2.2.2 ADDING EARTHSERVICE AS A NETWORK LINK 

1. Open Google Earth by doing one of the following: 

 Double-clicking the Google Earth icon on the Desktop. 

 Clicking Start > All Programs > Google Earth > Google Earth.  

5. From the Add menu, select Network Link. The New Network Link window displays (Figure 2.2). 

 

FIGURE 2.2  NEW NETWORK LINK WINDOW 

6. Enter a name in the Name field (Example: Imagery). 
7. Type the EarthService URL in the Link field (Figure 2.3). A sample is provided below. Figure 2.3 shows the 

dialog box with the information entered. 

Name: Imagery 
Sample URL: 
https://services.digitalglobe.com/earthservice/kmlaccess/DigitalGlobe:CitySphereTileService?connect
id=<ConnectID> 

Replace <ConnectID> with the ConnectID provided by DigitalGlobe. The URL varies for different 
users; ensure that there are no spaces in the URL. 

https://services.digitalglobe.com/earthservice/kmlaccess/DigitalGlobe:CitySphereTileService?connectid=(GUID)
https://services.digitalglobe.com/earthservice/kmlaccess/DigitalGlobe:CitySphereTileService?connectid=(GUID)
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FIGURE 2.3  ADD IMAGERY LINK EXAMPLE IN NEW NETWORK LINK DIALOG BOX 

8. Click OK. A new layer appears in the Places panel (see Figure 2.4). 

 

FIGURE 2.4  MY PLACES PANEL SHOWING IMAGERY LAYER 

2.3 Accessing DGCS MapService (ImageryFootprint) 

DGCS MapService can be added either as a network link or as an image overlay. 

2.3.1 ADDING MAPSERVICE AS A NETWORK LINK 

Perform the following steps to add DGCS MapService as a network link. 

1. From the Add menu, select Network Link. The New Network Link dialog box displays (Figure 2.2). 
2. Enter a name in the Name field (Example: Imagery Metadata). 
9. Type the EarthService URL in the Link field (Figure 2.3). A sample is provided below. 

Name: Imagery Metadata 

Sample URL: 
https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGl
obe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERL
AY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/

https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=(GUID)
https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=(GUID)
https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=(GUID)


 
DGCS in Google Earth User Guide | 12 

DGCS IN GOOGLE EARTH – USER GUIDE  

Copyright © 2013 DigitalGlobe Inc. Proprietary & Confidential 

vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-
90,180,90&connectid=<ConnectID> 

Replace <ConnectID> with the ConnectID provided by DigitalGlobe. The URL varies for different 
users; ensure that there are no spaces in the URL. 

10. Click OK to create required layers under the Places panel, as shown in the figure below. 

 

FIGURE 2.5  IMAGERY AND METADATA LAYERS UNDER MY PLACES 

 NOTE: If the folder icon shows a yellow or red ball, , there is a problem 
with the layer. If the layer was just created, check the URL for errors. If the icon was 
green and turned to yellow or red, then the URL is probably bad or down. 

The metadata populates in the My Places panel and can be expanded to display all of the imagery strips 
available (refer to Figure 2.6). 

 

FIGURE 2.6  METADATA LAYER UNDER MY PLACES PANEL (EXPANDED) 

The green dots in the imagery strips are Catalog IDs (Figure 2.7).   

https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=(GUID)
https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=(GUID)
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FIGURE 2.7  STRIPS & CATALOG IDS 

11. Click the Catalog ID links to see metadata attributes for the strip (Figure 2.8). Double-click to zoom.  

 

FIGURE 2.8  VIEWING ATTRIBUTES 

TABLE 2.1  METADATA COLORS 

COLOR TIME FRAME 

 

Imagery less than 7 days old 

 

Imagery between 7 and 30 days old 

 

Imagery more than 30 days old 
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 NOTE: Ensure sure that the layers are under My Places (as shown in Figure 2.11) 
because any layers stored in Temporary Places will not be saved when Google 
Earth is closed. 

 

FIGURE 2.9  MOVE LAYERS TO MY PLACES 

2.4 Accessing WCS via Google Earth (Delivery Service) 

Perform the following steps to add DigitalGlobe Web Coverage Service as a network link. 

1. From Google Earth’s Add menu, select Network Link. The New Network Link window displays (Figure 2.2). 
2. Enter a name in the Name field (Example: DigitalGlobe - WCS). 
3. Insert a WCS URL in the Link box, as illustrated in Figure 2.10. A sample is provided below. Figure 2.10 

shows the dialog box with the information entered. 

Name: DigitalGlobe - WCS 

Sample URL: 
https://services.digitalglobe.com/deliveryservice/wcsaccess?SERVICE=WCS&CONNECTID=<Conne
ctID> 

Replace <ConnectID> with the ConnectID provided by DigitalGlobe. The URL varies for different 
users; ensure that there are no spaces in the URL. 

 

FIGURE 2.10  NEW NETWORK LINK DIALOG BOX WITH WCS 

4. Click OK. WCS will populate in the Places column. 

 NOTE: If the .kml file is used for access, all of the layers will be loaded, including 
Delivery Service. 

Zooming in on the map will eventually show various download icons ( ).The file sizes of downloading full 
resolution or screen resolution files in JPEG2000 format also shown (refer to Figure 2.12).  

https://services.digitalglobe.com/deliveryservice/wcsaccess?SERVICE=WCS&CONNECTID=%3cGUID%3e
https://services.digitalglobe.com/deliveryservice/wcsaccess?SERVICE=WCS&CONNECTID=%3cGUID%3e
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FIGURE 2.11  DOWNLOAD BUTTON 

12. Click the download button to see all download options: JPEG2000, GeoTIFF, MrSID, or GeoPDF files at 
either full resolution or at screen resolution (Figure 2.12). 

 

FIGURE 2.12  IMAGE FORMAT DOWNLOAD LINKS 

13. Click one of the links to initiate the download. Confirmation text displays, stating that the download has been 
initiated. When the download is complete, a File Download dialog box displays (Figure 2.13). 
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FIGURE 2.13  FILE DOWNLOAD DIALOG BOX 

14. Click Save to save the file to your computer. 
15. Add the coverage to a map (like in ArcMap, as shown in Figure 2.14), or open it in a browser to view. 

 

FIGURE 2.14  VIEW MAP – WCS 

Refer to Table 2.2 for sample URLs. 

TABLE 2.2  SAMPLE URLS 

DGCS DATA LAYER URL 

EarthService (Imagery) https://services.digitalglobe.com/earthservice/kmlaccess/DigitalGlobe:CityS
phereTileService?connectid=<ConnectID> 

https://services.digitalglobe.com/earthservice/kmlaccess/DigitalGlobe:CitySphereTileService?connectid=(GUID)
https://services.digitalglobe.com/earthservice/kmlaccess/DigitalGlobe:CitySphereTileService?connectid=(GUID)
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MapService (ImageryFootprint) https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&widt
h=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=
wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMAR
K:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/
vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-
90,180,90&connectid=<ConnectID> 

Web Coverage Service https://services.digitalglobe.com/deliveryservice/wcsaccess?SERVICE=WC
S&CONNECTID=<ConnectID> 

2.5 Verifying Layers in Google Earth 

Select the checkboxes for all the layers under My Places in order to make them all visible (see Figure 2.15). 

 

FIGURE 2.15  MAKING LAYERS VISIBLE 

The metadata will show up at higher elevations as an outline with the timestamp at the center. The Region Tile’s 
metadata is light blue in color. The metadata for strips is color-coded. 

TABLE 2.3  METADATA COLORS 

COLOR TIME FRAME 

 
Imagery less than 7 days old 

 

Imagery between 7 and 30 days old 

 
Imagery more than 30 days old 

Zoom to one of the Area of Interest (AOI) sites. You should start seeing the metadata at an altitude above 8,700 
miles. 

 NOTE: The imagery layer is set to display at map scales of 1:200,000 and greater. 
This includes both EarthService and MapService. The best way to view coverage is 
to bring up the metadata layer (viewable at all scales) and then zoom in to the 
image strip until the imagery displays. 

2.6 Installing Certificates 

After creation of imagery and imagery metadata in Google Earth, the login may also prompt the user to verify the 
certificate for server authentication (Figure 2.16). 

https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=(GUID)
https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=(GUID)
https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=(GUID)
https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=(GUID)
https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=(GUID)
https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=(GUID)
https://services.digitalglobe.com/deliveryservice/wcsaccess?SERVICE=WCS&CONNECTID=%3cGUID%3e
https://services.digitalglobe.com/deliveryservice/wcsaccess?SERVICE=WCS&CONNECTID=%3cGUID%3e
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FIGURE 2.16  SECURITY ALERT POPUP 

To install certificates, follow these steps: 

1. In the Security Alert dialog box, click View Certificate. The Certificate dialog box displays (Figure 2.17). 

 

FIGURE 2.17  CERTIFICATE - GENERAL TAB 

16. Verify that the certificates are ”services-stage” and click Install Certificate…. The Certificate Import 
Wizard opens (Figure 2.18). 



 
DGCS in Google Earth User Guide | 19 

DGCS IN GOOGLE EARTH – USER GUIDE  

Copyright © 2013 DigitalGlobe Inc. Proprietary & Confidential 

 

FIGURE 2.18  CERTIFICATE IMPORT WIZARD 

17. Click Next. The Certificate Store screen displays (Figure 2.19). 

 

FIGURE 2.19  CERTIFICATE STORE LOCATION 

18. Ensure that the option Automatically select the certificate store based on the type of certificate is selected. 
Click Next. 

19. Click Finish. The Security Warning window displays (Figure 2.20). 
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FIGURE 2.20  SECURITY WARNING 

20. Click Yes. 
21. A pop-up message stating, “The import was successful” appears. Click OK to complete the certificate 

installation. 

2.7 Working with Layers 

2.7.1 SAVING A LAYER 

To save a layer: 

1. On the Places panel, right-click a layer and select Save Place As. The Save File window displays (Figure 
2.21). 

 

FIGURE 2.21  SAVE FILE SCREEN 

22. The file name defaults to the name previously given to the layer. To change the name, edit the File name 
field. 

23. From the Save as type drop-down, select Kmz (*.kmz). 
24. Click Save. 

2.7.2 LOADING A LAYER 

To load a layer in Google Earth, perform the following steps: 

1. From the File menu, select Open. The Open window appears (Figure 2.22). 
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FIGURE 2.22  LOADING A LAYER 

25. Select the layer KMZ file you want to load and click Open. The layer will display under Temporary Places in 
the Places panel (Figure 2.23). Ensure that the checkbox next to the layer is selected in order to view the 
layer. 

 

FIGURE 2.23  VIEWING LOADED LAYERS 

2.7.3 CREATING LAYER TEMPLATES 

You can use templates to easily create Google Earth layers. Create a template by following these steps: 

1. Follow the steps mentioned in Adding EarthService as a Network Link on page 10 to create the layers. 
However, omit appending the <ConnectID> for each of the layers. 

26. Save the layers as outlined in Working with Layers on page 20. These layers are saved in a file format that 
can easily be transferred to another computer.  

27. To install the EarthService layer, select File > Open. The Open dialog box displays (Figure 2.22). 
28. Navigate to the KMZ template file you created. This will create the template layer without the CONNECTID.   
29. Right-click each layer and select Properties. The Edit Network Link window displays (see Figure 2.24). 
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30. In the Link field, type your ConnectID after the …connectid=. 

 

FIGURE 2.24  ADDING THE CONNECTID TO THE NETWORK LINK 

31. Click OK. 
32. Once created, move the layers to My Places in the Places panel (see Figure 2.9). 

2.8 Applying Filters 

When using MapService, you can filter the supplied data by including filter parameters in the WMS URL. Filters can 
be applied based on the following metadata attributes:  

 Image Acquisition Date 

 Cloud Cover Percentage 

 Catalog ID 

 Age in Days  

 Off Nadir Angle 

 Sun Elevation 

 Sun Azimuth 

Metadata filters begin with the following tag CQL_FILTER=, while raster coverage (imagery) filters begin with the tag 
COVERAGE_CQL_FILTER=. Table 2.4 lists the available filters and their image calls. 

TABLE 2.4  FILTER CALLS 

FILTER PARAMETER DESCRIPTION 

EXAMPLE CALL  

(PREFACED WITH &CQL_FILTER= OR 

&COVERAGE_CQL_FILTER=) 

Catalog ID The catalog ID for the image strip. Catalog_identifier=’1020010007808500’ 

Image Acquisition 
Date 

The date that the image was acquired (in 
GMT). 

Acquisition_date>’5/1/2009’ 

Age in Days 
The age (in days) of the image from today’s 
date. 

Age_days<14 

Off Nadir Angle 
The off-nadir angle of the image. This is the 
angle off of 0-degrees that the satellite is 
pointed to take the image. 

Off-nadir_angle<25 
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Cloud Cover % 
The cloud cover percentage for the portion 
of the strip covering the area of interest. 

Cloud_cover<.20 

Sun Elevation 
This is the angle between the horizon and 
the sun at time of acquisition or the sun 
elevation of the image. 

Sun_elevation>15 

Sun Azimuth 
This indicates (on a 360-degree scale) 
where the sun is in relation to the image on 
the ground or the sun azimuth of the image 

sun_azimuth<240 

 NOTE: The value for cloud cover percentages are given in decimal format. For 
example, a value of 0.09 represents 9% cloud cover and a value of 0.99 represents 
99% cloud cover. Values for Image dates and Catalog ID must be enclosed in 
apostrophes. For example, ‘5/7/2009’DGCS TIPS. 
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3 Improving Performance 

3.1 Refreshing the Imagery 

The DGCS links do not refresh dynamically. In order for new imagery to populate in the DGCS layers, you must try to 
add the link again into your software or restart your application (if you have saved the layer in My Places). New 
imagery will not populate into your layer until the link is added again or the application is re-started. 

3.2 Clearing Temporary Internet Files 

Clearing your temporary Internet files can improve performance. 

1. In Internet Explorer, from the Tools menu, select Internet Options. The Internet Options dialog box 
displays (Figure 3.1). 

33. On the General tab, under Browsing history, click the Delete button. 

 

FIGURE 3.1  INTERNET OPTIONS DIALOG BOX 

34. Click the buttons to delete Files, Cookies, History, and Forms. You can also select to delete Passwords 
but this will delete any saved passwords you have in your system, which generally do not use much 
memory.  
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FIGURE 3.2  DELETE BROWSING HIST ORY 

35. When you are finished, click Close and then OK. 

3.3 Clearing the Google Cache 

Clearing out the Google Earth cache can improve performance.  

1. In Google Earth, from the Tools menu, select Options. The Google Earth Options dialog box displays 
(Figure 3.3). 

 

FIGURE 3.3  CLEAR CACHE 

36. On the Cache tab, click the Clear memory cache and Clear disk cache buttons. 
37. Click OK. 
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3.4 Uncheck Extraneous Layers in Google Earth 

If your layers seem to be running slowly, or if your computer runs slowly when the DGCS layers are loaded into a 
Google client, try this tip. From Google Earth’s View menu, deselect some layers (for example, Atmosphere, Sun, 
Historical Imagery, and Water Surface).  

.  

FIGURE 3.4  UNCHECK EXTRANEOUS LAYERS 

3.5 Google Earth Toolbar 

The following table describes the buttons on the Google Earth toolbar. 

TABLE 3.1  GOOGLE EARTH TOOLBAR  

BUTTON NAME DESCRIPTION 

 
Show/Hide Sidebar Click to show/hide the sidebar. 

 Add Placemark Click to mark a place on the map. 

 Add Polygon Click to add a polygon. 

 Add Path Click to add a path. 

 Add Image Overlay Click to overlay an image. 

 Record a Tour Record your movements around the map, with or without audio narration. 

 Show Historical Imagery 
View historical imagery over timelapse. Use the time slider to see images 

from a certain timeframe. 

 Show Sunlight 
View the sun’s position over the selected area. Use the time slider to see 

images during specific timeframes. 

 Switch Planets View the Earth, Sky, Mars or Moon. 

 Show Ruler Specify the measurements by which to guage the imagery. 

 Email 
Attach one of the following to an e-mail: screenshot, KML (for Google 

Earth), or Selected Placemark/Folder (for Google Earth). 



 
DGCS in Google Earth User Guide | 27 

DGCS IN GOOGLE EARTH – USER GUIDE  

Copyright © 2013 DigitalGlobe Inc. Proprietary & Confidential 

 Print 
Click to print one of the following: screenshot of 3D view, recent search 

results, or selected My Places folder 

 View in Google Maps Click to open the image in Google Maps. 
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4 Good to Know 

4.1 Layers 

A layer refers to various overlays of data, each of which normally deals with one thematic topic. These overlays are 
registered to each other by the common coordinate system of the database. 

 

FIGURE 4.1  GIS LAYERS 

The figure above shows a map. The top layer shows the symbols representing the location of houses, factories, or 
commercial centers. The black lines represent the land use boundary. The middle layer shows the land use map and 
the bottom layer is the conversion from the land use map into raster model. 

4.2 Zoom Levels 

Zoom Level is a capability for proportionately enlarging or reducing the scale of a figure or map. 

DigitalGlobe Cloud Services uses a multiple-image layer to depict the globe, which depends upon spatial resolution. 
The displayed image at a particular zoom level will be directly proportionate to the spatial resolution of the satellite 
data. Each zoom level will display images based on the visibility factor and ground representation factor. The figure 
below illustrates the systematic display of satellite images based on the spatial resolution. 
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FIGURE 4.2  ZOOM LEVELS 

DGCS offers 20 different zoom levels for displaying imagery. Each zoom level uses images from different sources, 
and provides varying resolution, as shown in Table 4.1. 

TABLE 4.1  ZOOM LEVELS 

RESOLUTION LEVEL PIXEL RESOLUTION ZOOM LEVEL SOURCE 

Low 2.4 km to 7.8 km 1 to 6 terracolor 

Medium 70 m to 1.2 km 7 to 11 terracolor 

High .15 m to 30 m 12 to 20 QB, WV1, WV2, aerial 

Users have access to imagery based on their subscription with DigitalGlobe. Please contact us for more information 
about subscription levels. 

4.3 Raster and Vector Data 

Raster data is an abstraction of the real world, where spatial data is expressed as a matrix of cells or pixels with 
spatial position implicit in the ordering of the pixels. With the raster data model, spatial data is not continuous, but 
divided into discrete units. This makes raster data particularly suitable for certain types of spatial operation, for 
example overlays or area calculations (refer to Figure 4.3). Raster structures may lead to increased storage in certain 
situations, since they store each cell in the matrix regardless of whether it is a feature or simply ‘empty’ space. 
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FIGURE 4.3  RASTER DATA 

Vector Data 

Vector is a data structure used to store spatial data. Vector data comprises lines or arcs, defined by beginning and 
end points, which meet at nodes. The locations of these nodes and the topological structure are usually stored 
explicitly. Features are defined by their boundaries only and curved lines are represented as a series of connecting 
arcs. Vector storage involves the storage of explicit topology, which raises overhead. However, it only stores those 
points which define a feature and all space outside these features is 'non-existent.' 

A vector-based GIS is defined by the spatial and thematic representation of its geographic data. According to the 
characteristics of this data model, geographic objects are explicitly represented and, within the spatial characteristics, 
the thematic aspects are associated. 

There are different ways of organizing this double database (spatial and thematic). Usually, vector systems are 
composed of two components: the one that manages spatial data and the one that manages thematic data. This is 
the named hybrid organization system, as it links a relational database for the attributes with a topological one for the 
spatial data. A key element in these kinds of systems is the identifier of every object. This identifier is unique and 
different for each object and allows the system to connect both databases. Refer to Figure 4.4. 

 

FIGURE 4.4  VECTOR DATA 

4.4 KML and KMZ 

Keyhole Markup Language (KML) is a file format used to display geographic data in an Earth browser such as 
Google Earth, Google Maps, and Google Maps for mobile. 

A Keyhole Markup Language Zip (KMZ) file consists of a main KML file and zero or more supporting files that are 
packaged using a Zip utility into one unit, called an archive. The KMZ file can then be stored and emailed as a single 
entity. A network link can fetch a KMZ file from a web server. When the KMZ file is unzipped, the main .kml file and its 
supporting files are separated into their original formats and directory structure, with their original filenames and 
extensions. In addition to being an archive format, the zip format is also compressed. So an archive can include only 



 
DGCS in Google Earth User Guide | 31 

DGCS IN GOOGLE EARTH – USER GUIDE  

Copyright © 2013 DigitalGlobe Inc. Proprietary & Confidential 

a single large KML file. Depending on the content of the KML file, this process typically results in 10:1 compression. 
Your 10 Kbyte KML file can be served with a 1 Kbyte KMZ file. 

Google Earth and Google Maps can read KML and KMZ files directly, and they can save files as KMZ files. By 
default, the main KML file is named doc.kml. 

4.5 Metadata 

Metadata is a summary document providing content, quality, type, creation, and spatial information about a data set. 
It can be stored in any format such as a text file, Extensible Markup Language (XML), or database record. Because of 
its small size compared to the data it describes, metadata is more easily shareable. By creating metadata and 
sharing it with others, information about existing data becomes readily available to anyone seeking it. Metadata 
makes data discovery easier and reduces data duplication. 

GIS metadata has a spatial component such as the extent of the Earth's surface the data covers. Metadata can 
describe GIS data, a GIS Cloud Service, or an online metadata catalog. Metadata can also describe non-electronic 
data, such as paper maps or offline electronic data such as data stored on CD or tape media. Open standards for 
metadata enable the data clearinghouse concept, also known as a catalog service.  

4.6 Image Content Specification 

The key features of satellite imagery are provided in this section. 

Coverage 

The spatial and temporal extent(s) pertaining to the satellite coverage relates to the content of the image, rather than 
its collection or management. Likely coverage includes the spatial location (whether it is a grid reference, place name, 
or more ephemeral locator) and temporal period (whether a date, date range, or period label. 

Sensors 

Each satellite carries sensors which measure the amount of visible light, thermal (infrared) radiation, and radiation 
from other parts of the electromagnetic spectrum coming from the Earth. Each sensor is only sensitive to a small part 
of the spectrum. So, multiple sensors are fitted to each scanner. 

Resolution 

The level of image detail or sharpness is determined by how many picture elements compose an area of display or 
corresponding raster object. Resolution may refer to sensors, raster objects, or displays. Low-resolution display 
devices produce images with a grainy visual texture. High-resolution displays use such small picture elements that 
they can produce a near-photographic quality image. 

Accuracy 

The difference between the locations of an object as specified in GIS, and its true location in the real world. 

Refresh 

The temporal change of the satellite image archive. 

Cloud Cover 

Cloud cover (also known as cloudiness, cloud age or cloud amount) refers to the fraction of the sky obscured by 
clouds when observed from a particular location. The coverage is represented by percentile. 

Off-Nadir Angle 

Nadir is when the satellite is looking straight down. QuickBird, a high resolution satellite owned and operated by 
DigitalGlobe, can be rotated to see targets on either side or ahead or behind. High off-nadir angles can mean lower 
quality in terms of geo-location accuracy and resolution, while tall objects can conceal targets. 

For new acquisitions, you can define the off-nadir range preferred. 0-10° is the minimum (better quality, but very long 
acquisition windows due to low revisit); 0-25° gives a good balance between quality and revisit time.  
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TABLE 4.2  CONTENT SPECIFICATION OF DIGITALGLOBE SATELLITE SERVICES 

  

CITYSPHERE ADDITIONAL 

WORLD 

METROS 

COUNTRY 

COVERAGE 

PRECISION AERIAL 

(U.S. & EUROPE) 

WORLD 

BASE 

MOSAIC 

SUMMARY Full color 
mosaic of the 
world’s top 
metros 

Full color 
mosaic of the 
world’s top 
metros, 
population, 
cultural features 

Extensive 
country 
coverage of 
DigitalGlobe's 
archive of 40 
top countries 

High resolution aerial 
imagery 

Mid resolution 
imagery layer 
covering the 
Earth’s entire 
land mass 

COVERAGE 300 Top world 
metros 

Over 1500 
population and 
cultural features 

Deep strip 
coverage of 
urban, rural 
and coastal 
areas 

Entire continental US 
and much of Western 
Europe 

Every 
continent and 
most islands, 
excluding 
Antarctica 

SENSORS Primarily 
QuickBird, 
WorldView-2, 
aerial in some 
regions 

QuickBird, 
WorldView-2 

QuickBird, 
WorldView-2 

DigitalGlobe aerial 
(metros), USDA, NAIP, 
USGS, Nat 1 map, 
USGS DOQQ 

NASA 
LandSat 
satellites 

RESOLUTION 60 cm or better 60 cm 60 cm 1 m to 16 cm 15 m 

ACCURACY Primarily 
1:12,000, some 
1:4800 and 
1:50,000 

1:50,000 1:50,000 1:12,000 to 1:4800 1:200,000 

REFRESH Yearly Varies. Updated 
periodically at 
DigitalGlobe 
discretion 

Varies. 
Additional 
content added 
quarterly 

Varies by location Varies 

CLOUD COVER Less than 10% Less than 10% Less than 20% Cloud free Cloud free 

OFF-NADIR ANGLE Less than 20° Less than 25°  Less than 20° Varies Varies 

4.7 DigitalGlobe Projection System 

Projection is a mathematical means of converting the three-dimensional model of the Earth’s surface to represent a 
two-dimensional medium – on plain paper or a computer screen. There are different methods to represent the Earth’s 
surface and each one has its own unique characteristics. Selection of a map projection system plays a key role for 
any kind of GIS. DigitalGlobe uses the following types of projection for their products: 

TABLE 4.3  LIST OF PROJECTION SYSTEMS USED BY DIGITALGLOBE PRODUCTS 

S.NO EPSG CODE DATUM 
COORDINATE  

SYSTEM 
ZONES 

1 3395 WGS 84 World Mercator   

2 26903 - 26923 NAD 83 UTM 3N - 23N 

3 900913 WGS 84 Simple Mercator   
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S.NO EPSG CODE DATUM 
COORDINATE  

SYSTEM 
ZONES 

4 4269 NAD 83 GEOGCS GCS   

5 26703 - 26722 NAD 27 UTM 3N-23N 

6 4267 NAD 27 GEOGCS GCS   

7 27700 OSGB 1936 British National Grid   

8 4231 European_1987 GEOGCS GCS   

9 32201-32230 & 32301 - 32360 WGS72 UTM 1N-60N and 1s-60s 

10 4322 WGS 72 GEOGCS GCS   

European Petroleum Survey Group (EPSG) 

EPSG Geodetic Parameter Dataset, or EPSG dataset, is maintained by the Geodesy Subcommittee of the Surveying 
& Positioning Committee of the International Association of Oil & Gas Producers (OGP). The European Petroleum 
Survey Group table defines numeric identifiers (the EPSG code) for many common projections and associate 
projection or coordinate metadata (such as measurement units or central meridian) for each identifier. 

The EPSG codes can be used to identify the Coordinate Reference System (CRS) for coordinates used in dataset 
encoded in GML (Geography Markup Language). They can also be used to request the desired map projection for 
a Web Map Service (WMS) GetMap request. 

Datum 

Datum is a mathematical model which approximates the shape of the Earth. The datum is physically represented by a 
framework of ground monuments whose position has been accurately measured and calculated on the reference 
surface (such as benchmarks). Lines of latitude and longitude on a map are referenced to a specific map datum. 

Coordinate System 

A coordinate system is a geometrical measurement of a position, using one or more reference points.  Coordinate 
system is a standardized method for assigning codes to locations, so that locations can be found using the code 
alone. Standardized coordinate systems use absolute locations. Some of the standard coordinate systems used are 
as follows: 

 Geographic coordinates (Lat-long, geodetic lat long, Earth Centered Earth Fixed XYZ) 

 Universal Transverse Mercator (UTM) system 

 World Mercator 

World Geodetic System - 84 

The World Geodetic System - 1984 (WGS 84) coordinate system is a Conventional Terrestrial System (CTS), 
realized by modifying the Navy Navigation Satellite System (NNSS), or TRANSIT, Doppler Reference Frame (NSWC 
9Z-2) in origin and scale, and rotating it to bring its reference meridian into coincidence with the Bureau International 
de l’Heure (BIH) - defined zero meridian. 

Origin and axes of the WGS 84 coordinate system are defined as following: 

 Origin = Earth’s centre of mass 

 Z-Axis = Direction of the Conventional Terrestrial Pole (CTP) for polar motion, as defined by BIH on the basis of 
the coordinates adopted for the BIH stations 

 X-Axis = Intersection of the WGS 84 reference meridian plane and the plane of the CTP’s equator, the reference 
meridian being the zero meridian defined by the BIH on the basis of the coordinates adopted for the BIH stations 

 Y-Axis = Completes a right-handed, Earth Centered, Earth Fixed (ECEF) orthogonal coordinate system, 
measured in the plane of the CTP  equator, 90° East of the x-axis. 
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Universal Transverse Mercator 

The National Imagery and Mapping Agency (NIMA) (formerly the Defense Mapping Agency) adopted a special grid 
for military use throughout the world called the Universal Transverse Mercator (UTM) grid. In this grid, the world is 
divided into 60 north-south zones, each covering a strip 6° wide in longitude. These zones are numbered 
consecutively beginning with Zone 1, between 180° and 174° west longitude, and progressing eastward to Zone 60, 
between 174° and 180° east longitude. Thus, the conterminous 48 States are covered by 10 zones, from Zone 10 on 
the west coast through Zone 19 in New England (Figure 4.5). In each zone, coordinates are measured north and east 
in meters. (One meter equals 39.37 inches, or slightly more than 1 yard.) The northing values are measured 
continuously from zero at the Equator, in a northerly direction. To avoid negative numbers for locations south of the 
Equator, NIMA's cartographers assigned the Equator an arbitrary false northing value of 10,000,000 meters. A central 
meridian through the middle of each 6° zone is assigned an easting value of 500,000 meters. Grid values to the west 
of this central meridian are less than 500,000; to the east, more than 500,000. 

 

FIGURE 4.5  UNIVERSAL TRANSVERSE MERCATOR GRID 

4.8 Stacking Profiles 

Stacking Profiles are configurable by customer and account. Stacking profiles determine which imagery is displayed 
first in cases where a particular image is not requested but multiple are available. These stacking profiles will be used 
to help customize the same library for different segments, users and needs. It determines the default imagery 
according to a user or account preference. If a request is made to DigitalGlobe’s services for a particular area (but not 
for a particular image ID or metadata), Stacking Profiles “choose” which image to respond to the request. 
DigitalGlobe provides four stacking profiles: 

Default 

The default stacking profile provides the most-recent image among available images as the default. There is no low 
resolution base mosaic. This profile begins returning imagery at zoom level 13. 

Cloud Cover 

The Cloud Cover stacking profile will return the image with the lowest available cloud cover by default. The base 
mosaic for this dataset is NaturalVue. Available for all zoom levels. 

Accuracy 

The Accuracy stacking profile will return the image with the best available accuracy by default. The base mosaic for 
this dataset is NaturalVue. Available for all zoom levels. 

Currency RGB  

The Currency RGB profile excludes all panchromatic/black and white imagery from default responses, with the most-
recent imagery displayed. Available for all zoom levels. 
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True Currency 

The True Currency stacking profile provides the most-recent image among available images as the default. The base 
mosaic for this dataset is NaturalVue. Available for all zoom levels. 

Global Currency 

The Global Currency stacking profile provides the most-recent image among available images as the default. The 
base mosaic for this dataset is TerraColor. Available for all zoom levels. 

Consumer 

The Consumer stacking profile provides the most-aesthetic image by default, preferring aerial where available, then 
mosaics, then color imagery. The base mosaic for this dataset is TerraColor. Available at all zoom levels. 

4.9 Bounding Box 

The Bounding Box (BBOX) is a set of four comma-separated decimal, scientific notation or integer values 
representing the geo referenced bounding parameters of Area of Interest (AOI). These values specify the Minimum X, 
Minimum Y, Maximum X, and Maximum Y (in that order), expressed in units of the Spatial Reference System (SRS) 
of the request, such that a rectangular area is defined in those units.  

The four Bounding Box values indicate the outside edges of a rectangle. In Figure 4.6, Minimum X is the left edge, 
Maximum X the right, Minimum Y the bottom, and Maximum Y the top. The relation of the Bounding Box to the image 
pixel matrix is shown in the figure: the bounding box goes around the “outside” of the pixels of the image rather than 
through the centers of the border pixels. In this context, individual pixels have an area. 

Rules to follow while defining BBOX: 

 A Bounding Box should not have zero area.  

 Minimum X should be less than or equal to the Maximum X.  Minimum Y should be less than or equal to the 
Maximum Y. 

 

FIGURE 4.6  PICTORIAL REPRESENTATION OF BOUNDING BOX 

4.10 Understanding URL and Parameters 

The following table provides sample URLs for adding the DGCS in Google Earth. From the Sample URL, you may 
note that the parameter (marked in red) calls the corresponding Service. 
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TABLE 4.4  DGCS & SAMPLE URLS 

SERVICE LAYER SAMPLE URL 

EarthService 
(Imagery) 

CitySphereTileService https://services.digitalglobe.com/earthservice/kmlaccess/DigitalG
lobe:CitySphereTileService?connectid=<ConnectID> 

CountryCoverageTileSer
vice 

https://services.digitalglobe.com/earthservice/kmlaccess/DigitalG
lobe:CountryCoverageTileService?connectid=<ConnectID> 

CrisisEventTileService https://services.digitalglobe.com/earthservice/kmlaccess/DigitalG
lobe:CrisisEventTileService?connectid=<ConnectID> 

MapService 
(ImageryFootprint) 

ImageryFootprint https://services.digitalglobe.com/mapservice/wmsaccess?height
=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&requ
est=GetMap&service=wms&styles=date&format_options=SUPE
ROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATT
R:true,&srs=EPSG:4326&format=application/vnd.google-
earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-
90,180,90&connectid=<ConnectID> 

Web Coverage Service DeliveryService https://services.digitalglobe.com/deliveryservice/wcsaccess?SE
RVICE=WCS&CONNECTID=<ConnectID> 

https://services.digitalglobe.com/earthservice/kmlaccess/DigitalGlobe:CitySphereTileService?connectid=%3cConnectID
https://services.digitalglobe.com/earthservice/kmlaccess/DigitalGlobe:CitySphereTileService?connectid=%3cConnectID
https://services.digitalglobe.com/earthservice/kmlaccess/DigitalGlobe:CountryCoverageTileService?connectid=%3cGUID
https://services.digitalglobe.com/earthservice/kmlaccess/DigitalGlobe:CountryCoverageTileService?connectid=%3cGUID
https://services.digitalglobe.com/earthservice/kmlaccess/DigitalGlobe:CrisisEventTileService?connectid=%3cConnectID
https://services.digitalglobe.com/earthservice/kmlaccess/DigitalGlobe:CrisisEventTileService?connectid=%3cConnectID
https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=%3cConnectID
https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=%3cConnectID
https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=%3cConnectID
https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=%3cConnectID
https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=%3cConnectID
https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=%3cConnectID
https://services.digitalglobe.com/mapservice/wmsaccess?height=1024&width=1024&layers=DigitalGlobe:ImageryFootprint&request=GetMap&service=wms&styles=date&format_options=SUPEROVERLAY:false,KMPLACEMARK:false,KMSCORE:50,KMATTR:true,&srs=EPSG:4326&format=application/vnd.google-earth.kml+xml&transparent=false&version=1.1.1&BBOX=-180,-90,180,90&connectid=%3cConnectID
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5 DigitalGlobe Cloud Services (DGCS) 

5.1 Getting to Know DGCS 

DigitalGlobe’s Cloud Services unlock the power of the world’s largest online library of high-resolution Advanced Ortho 
imagery. With our extensive suite of OGC-compatible Cloud Services combined with our powerful hosting 
infrastructure, we can instantly deliver current, high-resolution imagery and geospatial information to desktops, 
portals, intranets and mobile devices around the world. 

 

FIGURE 5.1  DGCS PROCESSES 

5.2 Things You Can Do with DGCS 

The DigitalGlobe Cloud Services (DGCS) layers have been designed based on the Open Geospatial Consortium 
(OGC) standards and can be integrated easily with most GIS software clients and portals. It gives users the ability to 
access and view imagery, the associated data points or metadata specific to imagery and types of imagery (e.g. 
vector, raster, etc.). 

5.2.1  SEARCH AND DISCOVERY 

DigitalGlobe provides you with multiple ways to search the ImageLibrary, identify what imagery is available, and even 
access preview imagery for visual assessment. With these services, you can create a highly customized interface for 
your application, and let users discover imagery using the criteria that are important to them. DigitalGlobe supports 
OGC-compliant WFS, that offers metadata as well as access to low resolution imagery previews. 
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5.2.2  IMAGE DELIVERY 

Get maximum flexibility with access to high-resolution imagery in a wide range of compressed and uncompressed 
formats that can be integrated into nearly any kind of geospatial application. 

 Supports major OGC standards, including WMS, WMTS, WCS, WFS and KML 

 Compressed formats include JPEG, PNG, geospatial PDF, MrSID and more 

 Uncompressed format includes GeoTIFF 

 EarthService
™

 provides native compatibility for KML-based Earth Viewers, including Google Earth 

 ImageConnect plug-in delivers georeferenced, multi-temporal imagery into your ArcGIS application via a simple 
yet powerful interface. 

5.2.3  DATA INTEGRATION 

DigitalGlobe can host your geo-located data and deliver it alongside content from our ImageLibrary. By leveraging 
DGCS, we can provide you with a single, centralized solution for all your geospatial applications, from Google Earth 
to desktop GIS, Oracle Spatial or custom enterprise applications. 

5.2.4  AUTHENTICATION AND SECURITY 

DigitalGlobe recognizes that geospatial data can contain very sensitive information; therefore we have implemented 
the necessary security measures to ensure that your data is yours alone. 

 128-bit SSL encryption 

 Access to custom imagery catalogs based on rigorous authentication 

 Optional behind-the-firewall solutions that can be deployed within your secure environment 

5.3 Personalized Access 

DGCS enables us to create tailored imagery programs to suit your needs, from the entire globe to a set of strategic 
sites. Whether you are supporting navigation devices or monitoring specific areas of interest, we can deliver the right 
imagery, at the right time, for the right price. 

5.4 Types of DGCS and Definitions 

5.4.1  WEB MAP SERVICE (WMS) 

The DigitalGlobe Web Map Service (WMS) provides a simple HTTPS interface for requesting geo-registered map 
images from one or more distributed geospatial databases. A WMS request defines the geographic layer(s) and area 
of interest (AOI) to be processed. The response to the request is one or more geo-registered map images (returned 
as JPEG, PNG, etc.) that can be displayed in a browser application. The interface also supports the ability to specify 
whether the returned images should be transparent so that layers from multiple servers can be combined or not. 

5.4.2  WEB MAP TILE SERVICE (WMTS) 

A WMTS-enabled server application can serve map tiles of spatially referenced data using tile images with predefined 
content, extent, and resolution.  

The DigitalGlobe WMTS provides raster imagery data at multiple resolutions in predefined imagery tiles in PNG 
format. The Web Map Tile Service is similar to Web Map Service, but it enables better server performance in 
applications that involve several simultaneous requests. To improve performance, rather than creating a new image 
for each request, it returns small pre-generated images or reuses identical previous requests that follow a discrete set 
of tile matrices. This service is optimized for rapid image tile delivery for display on portals or applications where 
response time is of primary concern. 

5.4.3  WEB FEATURE SERVICE (WFS) 

The OGC WFS Interface Standard provides an interface allowing requests for geographical features across the web 
using platform-independent calls. While a WMS interface or online mapping portals like Google Maps return only an 
image, which end-users cannot edit or spatially analyze, the XML-based GML furnishes the default payload-encoding 
for transporting the geographic features. Other formats like shapefiles can also serve for transport. The OpenGIS 
GML Simple Features Profile is designed to increase interoperability between WFS servers and improve the ease of 
implementation of the WFS standard. 
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5.4.4  WEB COVERAGE SERVICE (WCS) 

The DigitalGlobe Web Coverage Service allows the end user to directly download raster imagery data. WCS supports 
four types of formats, namely; Geospatial PDF, MrSID, JPEG200 and GeoTIFF. The Service treats each available 
product as a separate coverage; therefore the imagery returned depends on the layer being accessed. If data is 
requested from the current layer, then the returned imagery product is a portion of a current layer strip collection. If 
the data is requested from the base layer, then the returned imagery product is a portion of a base layer. 

5.5 Cloud Services Data Types 

The DGCS system provides access to imagery, imagery products, and imagery metadata over the World Wide Web 
via a suite of standards-based, OGC-compliant Cloud Services. These services provide access to products contained 
in DigitalGlobe’s Online Catalogs. These catalogs contain metadata describing each of the available imagery 
products.  

The data available from these catalogs via each of the services is summarized in the table below. 

TABLE 5.1  CLOUD SERVICES DATA TYPES 

SERVICE TYPE OF DATA DESCRIPTION 

Web Map Service Product metadata;  

Raster maps 

Provides product metadata and map images for the OGC 
Layers of the online imagery catalogs. 

Web Map Tile Service Tiled raster maps Provides cached map tiles at multiple levels of resolution. 
Tiles are provided for specific OGC Layers. 

Web Feature Service Product metadata Provides product metadata in Geographic Markup Language 
(GML) format for each online imagery catalog. 

Web Coverage Service Full-resolution imagery Provides downloadable products for defined coverage 
areas; each product in the online finished product catalogs 
constitutes a separate coverage. 

The remainder of this document describes the detailed capabilities and data provided by each of the Cloud Services. 

5.6 Advantages of DGCS 

5.6.1  EASY OPERABILITY 

DGCS is powerful and easy to use. The advantages that emphasize easy operability are: 

 Compatibility with most of the leading GIS software tools 

 Minimal technical intervention for setting up the service 

 Functionalities are uncomplicated and easy for user initiation 

 Cloud Services can be easily integrated to custom applications, if required. 

5.6.2  THE DIGITALGLOBE CONSTELLATION 

DigitalGlobe owns and operates the most agile and sophisticated constellation of high-resolution commercial Earth 
imaging satellites. QuickBird, WorldView-1 and WorldView-2 together are capable of collecting over 500 million km

2
 

of quality imagery per year and offering intraday revisit times around the globe. Add to that our aerial program offering 
wall-to-wall coverage of the U.S. and Western Europe. 

There is no longer a question of whether timely imagery is available. If we don’t already have what you need in our 
vast ImageLibrary, we can get it faster than ever before. With the addition of our newest satellite, WorldView-2: 

 80% of tasking orders were delivered within 25 days* 

 80% of Select Plus tasking orders were completed within 11 days* 

Our constellation features several technical advantages: 

 Largest sub-meter high-resolution constellation 

 Highest collection capacity 

 Outstanding geolocational accuracy 

 Largest high-resolution swath width 

 Greatest in-track stereo collection 

 Most spectral diversity commercially available 
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5.7 Support 

DigitalGlobe has worked to simplify the process of getting your imagery-supported applications up and running 
quickly. We can provide you with robust documentation and SDKs to speed up the implementation process, as well 
as extensions to standard GIS applications. Plus, our professional services team is ready to assist you in integrating 
our Cloud Services into your custom enterprise environment. 

Please contact DigitalGlobe at 800.496.1225 or cloudservices@digitalglobe.com. 

5.8 References 
 http://www.opengeospatial.org/standards 

 http://en.wikipedia.org/wiki/Web_Map_Service 

 http://en.wikipedia.org/wiki/Web_Feature_Service 

 http://www.opengeospatial.org/standards/wcs 

 http://en.wikipedia.org/wiki/GIS#OGC_standards 

 http://www.wikipedia.org/ 

 http://en.wikipedia.org/wiki/Geography_Markup_Language 
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Glossary 

AOI 

Area of Interest. The area on the Earth that you want to view. 

Bilinear Interpolation 

Bilinear interpolation uses the value of the four nearest cell centers to determine the value on the output raster. 
The new value is a weighted average of these four values, adjusted to account for their distance from the center 
of the output cell. The result is a smoother-looking surface than provided by “nearest neighbor”.  

Bicubic Interpolation 

Bicubic interpolation combines data points on a two-dimensional grid. This method outputs the smoothest 
surface of all interpolation methods. 

Geographic Projection 

 

GeoTIFF format 

A GeoTIFF file is a TIFF file that is embedded with geographic data tags. 

GML 

Geography Markup Language. GML is XML code used to express geographical features. 

JPEG2000 format 

The JPEG2000 format is a JPEG format that was introduced in the year 2000. It has considerable advantages 
over basic JPEG format including error resilience and progressive transmission. 

MrSid format 

Multi-Resolution Seamless Image Database. This format compresses large raster images while maintaining the 
image quality. 

National Imagery Transmission Format 

See NITF format. 

Nearest Neighbor Interpolation 

Uses the value of the closest point and disregards all other values, yielding a piecewise-constant interpolant. 

NITF format 

National Imagery Transmission Format. A United States Department of Defense standard for transmitting and 
storing digital imagery. 

OGC 

Open GIS Consortium. An international standards organization comprised of commercial, governmental, 
nonprofit and research organizations. They support geospatial content development as well as data processing 
and sharing. 

OWS 

OGC Web Service Common. 

Seamlines 

Overlapping raster datasets can be blended along the seamline by a specified width. Seamlines are created with 
the Seamline extension tools, and are stored as shapefiles within the image service definition. 

Universal Transverse Mercator Geographic Coordinate System 

See UTM. 
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UTM 

Universal Transverse Mercator Geographic Coordinate System. UTM utilizes a two-dimensional Cartesian 
system to specify locations on the Earth’s surface. 

WCS 

Web Coverage Service. 

WebCGM 

Web Computer Graphics Metafile. 

WFS 

Web Feature Service. 

WMS 

Web Map Service. 

WMTS 

Web Map Tile Service. 
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